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Welcome! 
Nebula is a Windows-95 communications program written specifically for the Trimble 
Galaxy Inmarsat-C/GPS transceiver that offers a number of advantages over Trimble's 
DOS-based Galaxy program.  

• A real Windows application allowing data exchange and use of other programs 
concurrent with Galaxy communications. 

• The multi-threading features of Windows-95 are used to provide Galaxy 
communications without interference with the user interface.  

• A central Message Index window provides easy access to incoming and outgoing 
messages, and Message Icons provide feedback on message type and status. An 
optional split window provides Explorer-style access to the folders in use.   

• Use of the Windows MDI (Multiple-Document Interface) allows multiple Messages and 
the Message Index to be viewed and arranged as desired, and the usual Windows 
features can be used to copy text between applications.  

• A comprehensive Address Book stores Inmarsat addressing information for each 
Ocean Region as well as header lines required by email messaging systems (e.g. 
Comsat's C-Link email headers).  

• An OLE interface and a NMEA output provides access to the Galaxy's GPS information 
for other applications.  

Nebula has been designed as a single program file, Nebula.exe, with no .DLL extensions in 
order to simplify installation, de-installation and maintenance. Similarly, program setup 
is stored in a Windows 3.1-style initialize (.INI) file in the Galaxy directory rather than 
being buried in the system registry.  

Note: Nebula is not intended as a complete replacement for Trimble's DOS-based Galaxy 
program, and certain features of Galaxy have not been implemented in Nebula. 
Specifically, there is no support for Fleetnet messages or Data Reporting, and service 
features such as the Performance Verification Test (PVT) are not implemented.  
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Installation 

Installing Nebula for the first time 
Installing Nebula is straightforward. An Install.bat batch file is provided on the floppy to 
automatically create the required directories and copy the relevant files. 

To install, insert the Nebula floppy disc in the floppy disc drive, click the Start button, 
select Run… and enter a:install↵↵↵↵. The install batch file will create the required 
directories and copy the files from the floppy disc. Attempts to use an alternate directory 
will be completely unsuccessful at this time.  

A start menu entry is not created automatically, to do this manually follow these steps: 

• click Start at the left end of the Taskbar at the bottom of the screen 
• click Settings 
• click Taskbar 
• click the Start Menu Programs tab 

• click the New button 

• enter c:\Galaxy\Nebula.exe as the Command Line and click Next 
• Select the desired program group, or create a new group by clicking New Folder  
• Enter Nebula as the name of the program and click Finish. 

If you want Nebula to start automatically each time the computer is booted, Nebula can 
be added to the StartUp program group following the above procedure. Each program in 
the StartUp group is executed automatically when Windows boots. A program can be in 
the StartUp group in addition to any other group. 

A Desktop shortcut is also a convenient way to start commonly-used programs. To create 
one: 

• Right-click on a blank area of the Desktop (i.e. click with the right mouse button) 

• select New and then Shortcut from the pop-up menu 

• enter C:\Galaxy\Nebula.exe as the Command Line and click Next 
• Enter Nebula as the name of the program and click Finish. 

if there are Galaxy messages already in the \Newmail and \Messages folders when 
Nebula is run for the first time, then Nebula will scan the folders and the log files and 
build a new Message Index (saved in MsgList.txt). This may take some time if there 
are a large number of messages on first start-up. If archive log files have not been written 
by Galaxy, then the information in the Message Index will be sketchy but all of the files 
will be represented. Nebula maintains archive logs in the same format as Galaxy. 

Re-installing or updating Nebula 
If you have already installed and used Nebula, it can be re-installed or an update installed 
by re-running the Install batch program as described above. The install program will 
detect the presence of Nebula.ini and not copy this file from the floppy disc 
(otherwise all setup information would be lost). If you copy files manually, DO NOT copy 
Nebula.ini from the floppy. 
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Note that the Address book, template and LES files (AddrBook.txt, AddrTemp.txt, 
LESlist.txt, LESequiv.txt) are used for initial startup only, and once Nebula has 
been run for the first time the data is stored in the Nebula.ini file. When Nebula is 
updated, new copies of these files will be placed in the Galaxy directory but will not be 
used unless the corresponding section of Nebula.ini is deleted. This avoids corruption 
of user data, but on occastion it may be desirable to incorporate an updated list of 
address templates (AddrTemp.txt) for example. Changes can be made directly in 
Nebula.ini, but be careful to preserve the correct format. 

Files 
Files that Nebula uses or generates are as follows: 

On the distribution floppy: 

Nebula.exe - the main execution file (self-contained, no .DLL's) 
Nebula.hlp - help file 
Nebula.cnt - help contents 
Nebula.ini - skeleton initialization file (with a temporary password) 
NebTest.xls - A simple Excel macro to test the OLE link for Galaxy position 

The following files are distributed on the floppy, but are stored in Nebula.ini once the 
program has been run the first time. 

LESlist.txt - the list of all known LES numbers and their locations * 
LESequiv.txt - list of equivalent LES's in each ocean region * 
AddrBook.txt - the initial address book (a smaple is on the floppy) * 
Addrtemp.txt - Address templates for creating new address book entries * 

Not on the distribution floppy, but generated by Nebula: 

MsgIndex.txt - the message index, saved between sessions 
Debug.txt - The debug file if Options/Debug is set  
Distress.txt - Distress message boilerplate text, if entered 
Nebula.gid - Help index, generated when Help is used the first time 
Nebula.kwd - Help Keyword directory, generated if Help/Find is used.  

You should also check that an Trash folder is added under \Galaxy, to store deleted 
mail messages (Install.bat does this). If this folder is not present then the files will 
be deleted outright.  
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Installation Options 
There are some Nebula options that may be of interest:  

Alarm Silence: 
The Trimble Galaxy firmware is configured to sound the audio alarm whenever an 
"Urgent" or "Distress" priority EGC message is received. This alarm will normally sound 
until manually acknowledged by pressing the Galaxy's "Quiet" button for two seconds.  

An Alarm Silence option is available when Nebula is running to turn off the EGC alarm 
automatically. If the Alarm Auto-Silence option is enabled (Galaxy/Options menu) and 
Nebula is running then the alarm will beep for a few seconds and shut off automatically.  

NOTE: This Alarm Auto-Silence feature contravenes the GMDSS requirements for ships 
and must not be used on vessels that are obligated to participate in the GMDSS, generally 
vessels over 300 gross tons.  

COM Port: 
The COM port can be set to COM1-COM8 via the Galaxy/Options Menu. The 
recommended port is COM1 and this is the default. 

Message Numbering: 
You may also want to define a starting number for Send messages. Send messages are 
numbered sequentially, in the same manner as the Galaxy program. The Nebula program 
maintains the last number used in the Nebula.ini file, so numbers are not reused even 
if the files are deleted. The file number is also incremented if a file of the same name is 
found, irrespective of the last number used by Nebula, in order to avoid conflicts with 
use of the Galaxy program.  

By default Nebula starts numbering outgoing messages at 1001 to avoid the Galaxy file 
numbers which start from 1. If you want to start numbering at some other point then the 
next sequential file number can be set by making an entry of the following form in the 
Nebula.ini file: 

[Messages]
LastSaved=2000

The next send message (in this example) will be named 00002001.C01. 

Nebula will save the full file name as LastSaved= and increment it for each message, 
but the above form works also.  

OLE Position Interface: 
If you want to use the Nebula OLE server feature to make lat/lon information available to 
another application, it will be necessary to register Nebula as an OLE server. This is done 
by choosing Run from the Windows Start menu and entering the command  

c:\Galaxy\Nebula.exe /Regserver  

If you want to un-register Nebula as an OLE server, enter the command 

c:\Galaxy\Nebula.exe /Unregserver 

Note that this is required only if you want to access lat/lon information via an OLE link 
(Refer to "OLE" in the Nebula help file).  
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Passwords: 
A password is required to enable Galaxy message communications. Without a valid 
password, basic Galaxy communications remain enabled but message send/receive is 
disabled (including EGC messages).  

Two types of passwords are provided for. The normal password is keyed to the Inmarsat 
Serial number, which is located on the label on the top of the Galaxy, and also read by the 
program via the RS-232 port. A normal password is prefixed by IPW- followed by the 
Inmarsat serial number and a check code. 

For demo use a temporary password is supplied, prefixed by UB-. The next six digits is a 
"Use-by" date in the format YYMMDD, and the remaining digits are a check code for the 
date code. Don't bother trying to crack it, just pay the asking price and take comfort that 
it goes to a good cause.  

Passwords are stored in the Nebula.ini file and can be entered with the Options dialog 
under the Galaxy menu. It is not necessary to exit and restart if passwords are changed, 
but if an invalid password is corrected then it may take some time (less than a minute) 
for full communications to be reestablished. 
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Introduction to the Inmarsat-C System 
The Inmarsat-C system is a world-wide messaging system providing global coverage 
between latitudes 70° north and 70° south. Coverage is divided into four overlapping 
Ocean Regions, called AOR/E, AOR/W, IOR and POR, each served by a geostationary 
satellite under the control of a Network Control Station (NCS). The role of the NCS is that 
of a referee, and all message communications are handled by one of a number of Land 
Earth Stations (LES) that service each Ocean Region. The LES's are the commercial service 
providers, transferring messages between mobile users and their shoreside contacts. 
Messages are sent on a store-and-forward basis, and can be delivered by telex, fax, or 
email, depending on the capabilities of the LES.  

The mobile terminal is called a Mobile Earth Station (MES), and must be logged into one 
of the four ocean regions in order to send or receive messages. There is generally no 
provision to store message and allow a user to log in at a later time and download 
messages. This means that the Galaxy DCE (the box) must be kept powered up to receive 
messages, but the computer and software can be shut down, and the "Mail" light on the 
Galaxy's front panel will alert the user that new mail is waiting.  

Each mobile user of the Inmarsat-C system is assigned a 9-digit identification number 
starting with a "4". This number, prefixed by a country code representing the Ocean 
Region, serves as a telex number for receiving messages over the international telex 
system. This mobile identification number also forms the basis for email addresses for 
messages sent over the Internet via one of the Internet-to-Inmarsat-C gateways 
(e.g. Comsat's C-Link and Station-12's SAT.400). 

Each mobile user has an affiliation with one LES, usually the primary service provider for 
the country of registration, but any mobile user is free to use any LES for 
communication. Unless an account is established with the LES, charges are billed through 
the national billing authority, the FCC in the USA, with additional service charges. Most 
service providers will set up a credit card account, may be the best option for non-
commercial users. 

The code most commonly used for message transfer is 7-bit ASCII, although 8-bit binary 
transfers can be made through some LES's. Messages sent over the telex system are 
transmitted via a 5-bit code, however, and lower case characters and all but the most 
basic punctuation are lost irrespective of which code is used between the LES and the 
MES. Messages sent to an email gateway generally use the 7-bit ASCII code. Sending 8-bit 
binary messages is possible in theory, but most email systems (including the Internet) are 
not capable of transmitting binary information with 8-bit codes.  

Other connections available, depending on the LES, are PSTN (Public Switched Telephone 
Network, i.e. the regular phone lines) and PSDN (Public Switched Data Network). Both 
have limited utility for the average user. PSTN connections are used to send faxes, and 
most LES's offer a text-to-fax service for outgoing faxes. Note that inward faxes aren’t so 
easy, as manual transcription is required, but some companies (e.g. Comsat) do offer that 
service for an additional fee. PSDN connections allow data transfers between systems, 
and are used by some service providers to provide a link to an LES outside their own 
service area (e.g. Comsat uses a PSDN connection to provide service to the IOR). 

Although some information is provided here with regard to the various services provided 
via Inmarsat-C, remember that all service arrangements must be made directly with the 
service provider.  
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Getting Started 

Overview of Nebula Windows and Features 
The "heart" of the Nebula program is the Message Index Window, which combines the 
functions of a message directory and a transaction log. An optional split window 
provides Explorer-style access to the message folders that are included in the index. 
Individual messages can be viewed in Message Windows, along with Galaxy Event 
Messages and Transmission Logs. Nebula is an MDI (Multiple-Document Interface) 
application, which allows these windows to be open together, and arranged in various 
ways within the main program window. Keyboard Shortcuts are available to simplify 
common tasks.  

Additional windows are provided for the Address Book for sending mail, for setting 
program options, and for new mail alerts; these windows appear for a specific task and 
are not part of the MDI structure.  

 

The Nebula program window has a Toolbar with an information box across the top and a 
status panel along the bottom, with the central area used by the Message Index and 
Message windows. The tool buttons (from left to right) are Show Folders, New, Open, 
Reply, Save, Send, File, Print, Delete, and Distress, and can operate in both the Message 
Index and Message Window where appropriate. The information area to the right of the 
toolbar displays the Galaxy GPS position and communication status. 

Status boxes at the bottom show (from left to right) Hints and Galaxy Transfers, Galaxy 
communication state, and UTC time and date.  

Toolbar buttons: 
Show/Hide Folder Tree. Click once (or type Ctrl/T) to split the window and show 
both the Message Index and Folder Tree; click again to restore single window for 
the Message Index. This button is active at all times, but the results are only 
visible when the Message Index is displayed.  

New Message. Opens a new blank Message Window, and opens the Address Book 
to allow selection of a recipient.  

Open Message. If selected from the Message Index window, opens a new Message 
Window for the currently selected message(s). If selected from the Message 
Window, displays the Windows Open-file dialog window. 

Reply. Formats a reply to the message selected in the Message Index, or the 
current message opened in a Message Window. This function is only enabled for 
incoming messages with a recognized address.  

Save Message. Only works for an outgoing Message from a Message Window, and 
saves any changes. If no other file name has been assigned (with the File/Save 
menu) then a sequential numerical file name is generated automatically. If a 
message has already been sent and then is subsequently changed it will be saved 
as a new message.  

Send Message. Works for the selected messages in the Message Index, or the 
current message in a Message Window. Marks the selected messages with the Send 
icon ( ) in the Message Index, and transfers them to the Galaxy for transmission.  
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File Message. Works for the selected message(s) in the Message Index, or the 
current message in a Message Window, and transfers messages to the folders 
defined by the Tools/Options/Folders setup window.  

Print Message. Works for the selected message(s) in the Message Index, or the 
current message in a Message Window. Displays the Print dialog and then prints 
the message(s) on the selected Windows printer.  

Delete Message from Index. Works for the selected message(s) in the Message 
Index, or the current message in a Message Window. If there is a \Trash folder, 
deleted mail messages (not EGC) are transferred there.  

Open Address Book. Opens the Address Book window, works from either the 
Message Index or Message Window.  

Distress. Opens a new Distress Message and displays a dialog window to select an 
LES as a destination.  

The remainder of the tool panel shows the vessel’s position and course and speed over 
the ground from the Galaxy's integral GPS receiver. If the information is current it will be 
suffixed with a "gps" notation, and if the data is old it will appear with a ">4hr" or ">24h" 
notation indicating that the data is more than 4  hours or 24 hours old. (In this case the 
GPS processor is most likely hung and a Galaxy reset is required).  

The right-hand portion of the tool panel shows the received signal strength from the 
satellite, the LES that is currently connected, and the ocean region that the Galaxy is 
logged into. "NCS:" indicates the current LES and will normally be the appropriate control 
station, 044, 144, 244 or 344. When data is being sent or received the indicated NCS will 
indicate which LES is connected. The "Logged in:" indicator will continue to indicate the 
currently logged ocean region, followed by the lock status:  "lock" for phase locked and 
synchronized, "phase" for locked but not synchronized, and "----" for not locked.  

Menus 
Nebula menu commands are divided into seven groups, File, Edit, Galaxy, Distress, Tools 
Window and Help.  

File Menu:  
New ................................Opens a new message 
Open .............................Opens selected message, or brings up File-Open dialog 
Save ...............................Saves current message, assigning file name automatically 
Save As..........................Saves current message, bringing up file-save dialog 
Close ..............................Closes current message window 
Move ..............................Brings up file-move dialog window 
Send ..............................Send selected or open message to the Galaxy for 

transmission 
Reply ..............................Opens a new message as a reply to selected or open 

message 
File .................................Moves selected or open message to designed "save" folder 
Delete .............................Deletes the selected or open messages (i.e. moves to Trash 

folder) 
Print ...............................Prints the selected or open message 
Exit .................................Closes Nebula and returns control to Windows 

Edit Menu (for Index Window): 
Delete .............................Deletes the selected message(s) (i.e. moves to Trash folder) 
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Edit Menu (for Message Window): 
Cut ..................................Moves selected text to clipboard and deletes it 
Copy...............................Moves a copy of selected text to clipboard without deleting 
Paste ..............................Adds text from clipboard to message at the insertion point 
Delete .............................Deletes selected text 
Select All .......................Selects all text 

Galaxy Menu  
Log In ..........................Logs the Galaxy into the specified Ocean Region 
Log Out .......................Logs the Galaxy out of the current Ocean Region 
Preferred OR.................Allows selection of the Preferred Ocean Region for scans 

and login 
EGC Setup ....................Brings up EGC Setup Window 
Forced Clear .................Sends a Forced Clear command to the Galaxy to abort 

current send 
Request Status.............Sends a Status Request message to the NCS (updates status 

icons upon reply) 
Reset Galaxy.................Resets Galaxy firmware (choice of hard or soft reset for 

4.20 firmware) 
NCS Scan .................... Initiates scan of all NCS channels (normally done 

automatically) 

Distress Menu 
Distress Alert ..............Brings up window to format Distress Alert 
Send Distress Message Creates new distress message, incorporating distress text 

Tools Menu 
Options ........................Opens Options window for Galaxy and program options 
Rebuild Index .............. Initiates a rebuild of the message index for all (non-hidden) 

folders 
Scrub Log Files ..........Scans log files and deletes redundant and obsolete entries 
Check "From" Addr ....Compares selected message to Address Book and updates 

"From" entry in Index 
View Debug File ..........Opens the debug file for viewing 
View Logs ...................Opens the selected log file for viewing 

Window Menu 
Tile Vertically ...............Arranges all open Message Windows and the Index Window 

as vertically-oriented panels 
Tile Horizontally ..........Arranges all open Message Windows and the Index Window 

as horizontally-oriented panels 
Arrange Icons ..............Reduces all windows to icons and arranges across the 

bottom.  
Address Book ..............Opens the Address Book window 
Distress Text ...............Opens the Distress Text for editing 
Event List .....................Opens a window for the most recent Galaxy Event 

messages 
Window List .................A list of open child windows 

Help Menu 
Contents ......................Opens the Contents window for Nebula Help 
Search for Help on ......Opens the Search window for Nebula Help 
How to use Help .........Opens the help-on-Help window 



Nebula 

Page 12  

About ...........................Displays revision and copyright information about Nebula 
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Logging In 
The first thing to do when starting up Nebula is to set 
the Preferred Ocean Region and log in to the NCS. 
Once the Preferred Ocean Region has been set with 
the Galaxy/Set Preferred OR command, it will be 
saved and used for subsequent scans and log-ins.   

It is recommended that mobile users periodically log 
in, even when a log out is not required in order to 
keep the information about the MES that is stored at 
the NCS up to date. If a Galaxy/Log In menu 
command is issued while the Galaxy is logged in, a 
log-out operation is performed automatically.  

EGC Setup 
 In order to receive EGC messages correctly, use the Galaxy/EGC Setup command to 
access the EGC Setup dialog window. EGC messages are transmitted on the NCS channel 
and are available to all mobile users. EGC messages include Notices to Mariners, Weather 
Bulletins, and Inmarsat service messages.  

EGC messages are addressed by the originator to a geographic area, either the entire 
Ocean Region, a specific Nav Area within the O.R., a rectangular area defined by lat/lon, 
or a radius around a specific lat/lon point. Service messages are typically sent to the 
entire O.R., weather messages and Notices to Mariners are addressed by Nav Area, and 
relayed distress messages are often addressed to a specific lat/lon area.  

The Galaxy has the ability to screen certain messages according to the parameters 
defined by the EGC Setup window. One primary and three alternate setups are available, 
each with a separate page. The recommended setup for the primary region is shown, with 
the current position defining which message will be received. The translation to Nav Area 
is made by the Galaxy. Alternately, messages for all Nav Areas (within the logged O.R.) 
can be selected.  
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To receive messages for other Nav Areas, for example the area to which you are headed, 
use one of the alternate setup pages, click the Nav Area button and enter the appropriate 
Nav Area code. (Nav Areas are often defined as Roman numerals but must be entered 
here as a conventional 1 or 2-digit numbers). Alternately, click Position and enter a 
lat/lon within the desired Nav Area.  

Under Selectable Services, the only choices available are General Calls and System 
Messages. For maritime applications the other message types are enabled and cannot be 
de-selected. It is recommended that General Calls and System Messages be left enabled, 
as they are few in number and include potentially important service announcements.  

Under the Coastal Regions headings, an option is provided to select a specific Navtex 
code. Some coastal forecasts on Inmarsat-C are formatted according to the Navtex 
format, with a two-letter code for the type of message. However, the coding by the 
originating stations is not consistent, and it is strongly recommended that the All Navtex 
Codes option be selected.  

Sending and Receiving Messages 
Reception of mail and EGC messages is automatic, and messages are added to the 
Message Index as they are transferred from the Galaxy. If the Nebula program is not 
running when a message is received, then it is saved in the Galaxy box and transferred 
when the program is started. When a mail message is received, a "New Mail" window pops 
up as an announcement, and a sound can be played (see Sound Options).  

An Outgoing Mail Message is created by opening a new message window, choosing an 
address from the Address Book, and composing the message. Outgoing messages can be 
sent immediately, or saved and sent later. The Message Index shows the status of 
outgoing messages, indicating whether they have been sent and the delivery status if 
sent.  

Sending a Distress Message is similar to sending a regular Outgoing Mail Message except 
an LES selection box appears instead of the Address Book. A Distress Alert is not a text 
message, but a coded alert, also sent to a specific LES.   

Saving Power 
The Galaxy DCE unit must be left powered on continuously in order to receive and store 
mail and EGC messages, but the computer may be shut down in order to save power. If 
the Nebula program is not running then messages will be accumulated in the Galaxy’s 
memory and will download automatically when Nebula is restarted. The memory in the 
Galaxy DCE box is limited and if it fills then the “Mailbox Full” light will come on and an 
alarm will sound. If the program is not restarted then the messages will be lost, starting 
with the oldest. Note that Nebula’s alarm silence feature only operates when the program 
in running.  

For more information on sending and receiving messages, see the following sections. 
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Message Index Window 
The Message Index is a separate window within Nebula that is used to view the status of 
messages that have been sent or received, and to provide an easy means of accessing the 
messages themselves.  

 The index window is divided into rows and columns, with each row representing one 
message. The format is similar to that used by the Windows Explorer, and most keyboard 
and mouse operations are the same. Messages can be sorted in either order by any 
column by clicking the column header; clicking the same column again reverses the sort 
order. Pressing the Esc key restores the default sort by date. 

Messages can be selected by either keyboard keys or the mouse, and multiple messages 
can be selected for most operations. See the following sections for more information.  

Message Index Layout 
The layout of the Message Index columns, from left to right, is as follows: 

Ref# ............ Reference Number and Icons for Message Type and Status 
Status......... Send Status for outgoing messages, priority for incoming messages 
To................Addressee for outgoing messages 
From........... Originator for incoming mail messages 
Size ............Message Size in bytes   
Date ............Message Date and Time  
File..............File Name 

Note that the last column or two of the message index may not be fully visible, 
depending on the column widths and the size of the window. The width of individual 
columns can be changed by positioning the cursor between the column headings (so that 
it becomes a "split" icon) and dragging the column divider left or right.  
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The index is normally sorted by date, most recent message first. Clicking on any of the 
column headers changes the sort key to that column, and clicking the same column again 
reverses the sort order. To revert back to a date sort, click the Date header button or hit 
the ESC key on the keyboard.  

Sorting by the "To" or "From" columns provides an easy way to find sequential messages 
to or from the same person. If you select a representative message first, then click the 
"From" column header (for example), the selected message will remain visible and the 
other messages from the same address will by displayed above and below (in 
chronological order if that was the previous sort).  

Message Index Operations 
Once one or more messages are selected (using any of the usual Windows selection 
methods), a number of operations can be performed either by menu selection, using a 
button on the Toolbar, or in some cases via menu operations or a keyboard key.  

Open: A Message Window can be opened to view or edit the selected message(s) by 

pressing the Enter key, double-clicking the Reference number, clicking the  

button on the toolbar, or selecting Open from the File menu. EGC and Incoming 
Mail Messages will be opened read-only and cannot be edited, but all or part of 
the text can be selected and transferred to a new outgoing message by selecting 
Copy and Paste from the Edit menu or using the right mouse button to access a 
pop-up menu.  

Reply: The (first) selected message can be replied to by clicking the  button on the 

toolbar or selecting Reply from the File menu. The reply function is only enabled 
for incoming mail messages with a "from" address that matches an entry in the 
address book.  

File:   The selected incoming message(s) can filed (stored in the designated archive 

directory) by clicking the  button on the toolbar or selecting File on the File 

menu. Filing an incoming message cleans up the Message Index and provides 
some protection against accidentally deleting it. 

Print:  The selected messages(s) can be printed on the selected Windows printer by 

clicking the  button on the toolbar, or selecting Print on the File menu. 

Send:  The selected outgoing messages(s) can be sent by clicking the  button on 

the toolbar or selecting Send from the File menu. 

Delete: The selected messages(s) can be deleted (or moved to the \Trash folder if there 

is one) by clicking the  button on the toolbar, selecting Delete from the File 

menu, or typing the Del key on the keyboard. Mail messages will be moved to 
the \Trash if there is one, otherwise deleted. EGC messages are always deleted. 
Messages that have not been read are only deleted or moved after confirmation.  

Reference Number:  
The message reference number is assigned by the Inmarsat-C system when a message is 
originated. Reference numbers are nominally unique, but duplicates can occur. File 
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names for incoming messages are created from the Reference Number with a .E01 
extension for EGC messages and .D01 for mail messages. In the event of duplicates, the 
extension is incremented, e.g. .E02. Note that EGC messages are typically transmitted two 
or three times, but the duplicates are trapped by the Galaxy DCE box and will only be 
seen if the first is incomplete.  

Message Icons:  
Two icons indicate message type and status. The first indicates Message Status, and the 
second, Message Type. 

Message Status for incoming messages: 

 indicates a new (unread) message 

 indicates a filed (saved) message 

Message Status for outgoing messages: 

 indicates that a transmission is pending  

  indicates that the Galaxy is waiting for delivery confirmation 

 indicates that the message was delivered (or sent without confirmation)  

 indicates that a transmission failed (open the Event List under the Window 
menu for more information). 

Message Types:  

 indicates a outgoing Send Message 

 indicates an incoming Mail Message 

 indicates a complete EGC message.  

Alternately, EGC messages can be indicated by 

 for a partial EGC message or  

 for an Urgent or Distress EGC message. 

Message Index Columns: 
The following columns are provided in the message index: 

Status:  The current status of the message, the message priority for incoming messages 
(Routine, Safety, Urgent or Distress), and the delivery status for sent messages 
(Sending and Sent if no delivery confirmation was requested, or "Sending", "Ack 
Req", "Delivered" or "Not Del" if delivery confirmation was requested). An 
abbreviation for a non-delivery code may be included, see "Abbreviations and 
Service Codes" in the appendix.  

To:   The message recipient's name for outgoing send messages (i.e. the familiar 
name from the address book). 

From:  The sender's name for incoming mail messages, either the familiar name if a 
match is found in the address book, or the Inmarsat number or email address if 
the format cannot be decoded, or blank if the format is unknown.  

Size :  The message size in characters as indicated by the Inmarsat system. Does not 
include embedded status or address codes used by Nebula (enclosed in square 
brackets). 
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Date:   The date and time stamp for the message. For incoming messages (mail and 
EGC), the date and time the message was received from the LES; for not-yet-sent 
outgoing messages, the date and time the message was first saved; and for 
transmitted messages, the date and time it was sent to the LES.  

File:  The folder and file name that the message is stored in. The folders for the 
various message types are as defined by the Tools/Options/Folders setup 
window.  

Using the Folder Tree 
The Message Index window can be split to show a Folder Tree view. To show the Folder 
Tree, click the left-most Folder Tree button on the toolbar or type Ctrl/T. To move 
between the Folder Tree and Message Index windows, either click on the appropriate 
window or hit the Tab key. To close the Folder Tree window, press the Folder Tree button 
or type Ctrl/T again, or press the ESC button while the Folder Tree is selected.  

The folders that are included in the displayed Message Index are indicated by an open-
folder icon ( ) and folders that are available but not included in the displayed index are 

indicated by a closed-folder icon ( ). To select one folder alone for the Message Index, 
simply move the mouse pointer to its folder icon and click once. This closes all other 
folders and displays the index for the selected folder. To include more than one folder 
(as in the example above) hold down the Shift key while clicking the folder; this will 
toggle the status of the selected folder without changing the others. To hide the Folder 
Tree again, hit Esc, type Ctrl/T, or click on any part of the Message Index. 

 The Folder Tree window shows all folders that are under the designated folder for 
Nebula (usually \Galaxy) except for those that are designated as "hidden". Folders can 
be hidden using the Tools\Options\Folders setup window. Alternately, right-click any part 
of the Folder Tree window and selecting Show Hidden. This will show the hidden folders 

in the Folder Tree with a "hidden folder" icon ( ). Generally the hidden folders include 
those not used for any incoming or outgoing messages, which simply serves to clean up 
the Folder Tree. The contents of those folders will not be altered, but they will not be 
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accessible from the message index unless they are unhidden (right-click the Folder Tree, 
then click Show Hidden again).   

See Routing and Folders in the Setting Options section for more information on 
message routing and folders. 



Nebula 

Page 20  

Receiving a Mail Message 
Mail messages are received automatically by the Galaxy and transferred to the PC if 
Nebula is running. If Nebula is not running then the messages are stored in the Galaxy 
memory and transferred when Nebula is started.  

When a new Mail Message is received, the "New Mail" window will appear alng with an 
audio alert if enabed (using the Galaxy/Options menu). In order to view the new 
message,  

Click the "Thanks" button or press the ESC or Enter keys to close the New Mail 
window. 

Find the new message on the Message Index for the new Mail Message. (The newest 
messages will be at the top of the index (if it is sorted by date, the default; if sorted by 
some other column, press ESC to return to the sort-by-date format). New, unread 
messages are marked with a  icon.  

Select the message to be read, and press Enter or click the "Open" button to display 
the message in a new Message Window. 

As an option, when you are viewing one message you can press the Alt + PgUp keys 
together (or Alt + ↑↑↑↑) to view the previous message on the index (one line higher on the 
index, however it is sorted), or Alt + PgDn keys (or Alt + ↓↓↓↓) to view the next message. 

To close the message window, press the Esc key, click the "X" (window-close icon), or 
select File/Close from the menu when you are finished reviewing your messages.  

To return to the Message Index without closing the Message Window, press the Alt + 
Home keys together. To sequence through the open Message Windows (and the Index) 
press Ctrl + Tab together.  

EGC Messages 
EGC messages are viewed in the same way as new mail Messages, except the "New Mail" 
announcement window does not appear. There are two special icons associated with EGC 
messages: 

Partial EGC messages are represented by a  icon. (This occurs, for example, if the 
signal fades or a message send interrupts EGC reception). 

"Urgent" or "Distress" EGC messages are represented by a  icon with an exclamation 
mark (and also by an audio alarm from the Galaxy unit. To silence the alarm 
automatically, see Options). 

If the "Show Header Info" option is selected in the Tools\Options window, the originating 
LES will be extracted from the message header and shown in the Message Index in the 
"From" column, i.e. "via Perth, Australia". Note that this is not the originating 
organization but simply the LES that transmitted the message.  
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Sending a Mail Message 
To send a message, follow these steps: 

• Select File/New from the menu, or press the  toolbar button. 

• A blank message will be created, and the Address Book opened. Select the 
recipient's name or add a new entry, and click OK. 

• Compose the message in the Message Window. 

• To save the message and send it immediately, click the  button (or select 

Send from the File menu). To save the message for sending later, click the  

button or select Save from the File menu.   

• Press the ESC key, or select Close from the File menu to close the Message 
Window.  

The send status of the message will be shown by the icons on the Message Index.  

See "Introduction to Distress Messages and Distress Alerts" for information on sending 
distress messages.  
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Printing Messages 
Messages can be printed by clicking the  button on the toolbar, or selecting Print 
from the File menu. A Print dialog window will be opened, allowing selection of the 
desired printer and setting of print options.  

Printer: Use the pull-down list to select 
from a list of currently installed printers. 
(To install a new printer, select Printers 
from the Window Control Panel). To 
change the settings for the selected 
printer, click the Setup button or type 
Alt/S.  

Margins: Set the margins appropriate for 
the selected printer and paper size. The 
default margins are the unprintable 
regions for the selected printer, and in 
most cases at least the left margin will 
want to be increased. Note that the 
margins are measured from the paper 
edge and are inclusive of the unprintable 
regions, which may differ from other 
Windows programs for certain printers.  

Font: The print font and size can be 
different from that used for the screen 
(10-point Courier New), and an alternate font may be chosen from the fonts list if 
desired. The fonts list includes printer fonts for the selected printer as well as TrueType 
fonts. While either will work, the printer fonts will generally result in faster printing.  
(The example above shows the use of the 12 char/inch printer font for an HP Thinkjet 
printer).  

Correct printing depends on correct installation of the printer, and on the correct 
settings being made. In the even of problems, check the printer settings carefully. Select 
Printers from the Windows Control Panel and open the Properties window for the desired 
printer (select Properties under the File menu or right-click the printer and select 
Properties). The setup varies with the printer, but special attention should be paid to 
Unprintable Area if it is available as an option, as the default setting will often not match 
the printer specs.  

 



Nebula 

Page 23  

Address Book 
The Address Book window is opened whenever a new outgoing message is created (New 
Message button or File/New menu), or via the Window/Address Book menu. A list of 
names is shown on the left side in the Name box, these are familiar names or nicknames 
assigned to each address. The address parameters for the currently selected name are 
shown in the remaining boxes. All parameters except the Message Preamble are stored 
separately for each Ocean Region, and are displayed as tabbed pages, one per OR. 
Clicking the appropriate tab will select the address parameters for that Ocean Region. 
The default tab is the Ocean Region currently logged into, or the most recent if not 
logged in.  

• Msg Type: Select from Telex, PSTN, CSDN, PSDN, X.400, Closed Network, Special 
Access Code or Other. The most commonly used are Telex, PSTN for outgoing fax 
messages, and Special Access Code for Internet email. 

• Char Code: Select from ASCII (7-bit alphanumeric) or Binary (8-bit) codes. 

• Country: Enter the telex or fax Country Code, or X.25 DNIC for PSDN data transfers.   

• Destination: Enter the telex number, fax area code and number, or X.25 Called 
Address for PDSN. 

• Prefix: Used for Special Access Code, not generally used for other formats.  

• Extension: Set to "T30" for sending an outgoing fax via PSTN, or to a modem code for 
certain modem connections.  

• Via LES: Select a LES station from a list of available stations.  

• Confirm Delivery: Check if Positive Delivery Confirmation is desired. This is usually 
an extra charge, and may not always be available or meaningful.  

• copy all: Determines whether changes made to one tabbed Ocean Region page are 
copied to the other Ocean Regions. If copy all is checked then any changes are copied 
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to other Ocean Region pages that initially had the same value; address parameters 
that were initially different are not changed. LES changes are never copied to another 
page.  

• Preamble: Allows optional entry of multiple lines of text to be attached to the 
beginning of each message sent to the corresponding address, typically used for 
Email Addressing. Note that each line is terminated with a paragraph symbol 
indicating the end-of-line; do not delete these or lines will be run together. A 
preamble for a Comsat C-Link email address would have the following form:  

To: name@domain.com¶ 
¶ 

Buttons are provided to create a new address and to delete or rename an existing entry, 
as well as the usual OK and Cancel buttons. New address entries are created from a 
template selected from a list, see Address Templates for information on modifying or 
creating templates.  

Two "radio buttons" are provided to allow changes to be made to the address templates. 
By selecting Templates, a list of address templates is displayed which may be changed or 
added to in the same way as mail addresses. Any parameters defined in  template will be 
copied into a new mail address when a new address is created. Note that any existing 
addresses based on that template will NOT be changed. The "|" character has a special 
meaning in templates, and the cursor will be automatically positioned at the first "|" 
character when a new address is created using that template.  

Email Addresses 
There are at least two Service Providers that will transfer messages between Internet 
email and the Inmarsat-C system. Comsat offers their C-Link service to all four ocean 
regions (via a PSDN connection to the IOR), and Station-12 offers their Sat.400 service to 
all four regions. The addressing requirements differ between the systems, and up-to-date 
information should be obtained upon registration. The following is offered as a guide 
and was correct at the time of publication. 

Comsat C-Link Email Gateway: 
Outgoing messages are sent to Special Access Code INET in all regions except the IOR, 
where a PSDN connection to 3110-2027183670 can be used. The beginning of the 
message defines the destination address, and the Address Book Preamble can be used to 
simplify addressing. The first line of the message must contain the email address in the 
following format: 

To: name@domain.com
(blank line) 

If it is desired to send to more than one address, or to include a subject line, the 
following format can be used: 

To: name1@domain.com, name2@domain.com
cc: name3@domain.com
Subject: subject line (optional) 
(blank line) 

Note that a blank line must always follow the C-Link header.  

Incoming messages (to the Inmarsat-C station) are simply addressed to the Inmarsat 
mobile number @C-Link.Net, for example 436742510@C-Link.Net 
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Station-12 Email Gateway 
Station-12 in Burum, Netherlands, offers Internet access via their SAT.400 email gateway. 
This is a X.400 gateway with Internet capability, and a simple "To: name@domain.com" 
style of addressing has been provided.  

Outgoing messages are sent to the Special Access Code "400" in all regions, or alternately 
via a X.25 connection to the PSDN number 2041-255010. Again, the beginning of the 
message defines the destination address, and the Address Book Preamble should be used 
to avoid errors. The first message line is a "To:" line, followed (optionally) by a "su:" line 
for subject, and finally an "stx:" line to indicate start-of-text. The "To:" line contains 
the internet address as follows: 

to: name1@domain.com  (required, one address only) 
cc: name2@domain.com  (optional, one address per line, multiple lines permitted) 
su: Message Subject (optional subject) 
stx:
(text starts here) 

Note the "stx:" start-of-text code on a line by itself, this is required by the gateway to 
separate the header from the message text itself.  

To receive messages from an Internet user, that user must be registered at Station-12, 
either with their own account or as an authorized address for your account. Messages 
sent by an Internet user are addressed by to mobile#@station-12.unisource.nl, 
for example: 

436742510@station-12.unisource.nl

Address Templates 
With the Address Book open (e.g. Window/Address Book menu), a new address can be 
created. Click the New button or Type Alt + N, and a new-address dialog window appears 
with an edit box for the familiar name (nickname), and a pull-down list for the address 
template. These templates define as many address parameters as possible, and define 
the Insertion Point when control returns to the Address Book.  

Changes to the Address Templates can most easily be made by opening the Address 
Book (e.g. Window/Address Book menu), and then clicking the Template button. A list of 
available templates will be shown, and they can be edited and new templates created in 
the same fashion as addresses. Note the use of the "|" character to define where the 
insertion point should be positioned when the template is used for a new mail address.  

The templates themselves are saved in the Nebula.ini file, and initially loaded from 
the file AddrTemp.txt which is included on the distribution floppy. The address 
templates are organized as four lines per template (one line per ocean region), with fields 
separated by semicolons. While changes can be made directly to the stored formats, it is 
recommended that the templates be maintained through the Address Book with the 
Template button selected as errors in the .ini file can cause serious and unpredictable 
malfunctions. Each template contains 12 semicolon-delimited fields, as follows: 

;LES;Type;;Code;PDN;;Prefix;Country;Destination;Extension;Preamble

The position for the Insertion Point (cursor) is indicated by a "|" character, and "¶" is used 
to mark new lines in the preample field.  
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Distress Messages and Distress Alerts 
There are two means of sending a distress signal from an Inmarsat-C unit: Distress 
Messages and Distress Alerts. In the Nebula program, both are accessed by selecting the 
Distress entry on the Main Menu, or typing Alt+D. Sending a Distress Messages can also 

be initiated by clicking the  button. 

The difference between a Distress Alert and a Distress Message is that an Alert sends the 
vessel position and an indication of the specific distress (if selected from the PC), but no 
text, while a Distress Message contains a text message but does not automatically 
indicate the vessel's position. A Distress Alert sent from the PC is the same as one 
initiated by pressing the Distress buttons on the Galaxy transceiver, except that the Alert 
initiated from the Galaxy is generic and indicates an unspecified distress (unless a 
distress type was previously specified and updated from the PC).  

In an emergency, first send a generic Distress Alert by pressing (and holding) the two 
red buttons on the Galaxy transceiver, then (optionally) activate a specific Distress 
Alert from the PC, and then send a Distress Message with the relevant details.  

A Distress Alert is a coded distress signal sent to a specific NCS or LES indicating the 
vessel's current position and a code for the nature of the distress. A Distress Alert is not 
stored as a message, and is not shown on the Message Index.  

A Distress Message is similar to a regular Outgoing Mail Message, except it is not sent to 
a specific address, only to a NCS or LES, and is sent with Distress priority. A Distress 
Message is saved and appears in the Message Index the same as an outgoing message 
with a To: address of DISTRESS: LES, with an icon to indicate its status. Distress 
Messages are always sent with a confirmation request. Remember that a Distress 
message does not automatically include the vessel's position. A Distress Message can 
only be sent if the Galaxy is logged into the Inmarsat system. 

When a Distress Message or Distress Alert is sent, it is received by the operating 
personnel at the NCS or LES and forwarded with top priority to the Rescue Coordination 
Center (RCC). A return message should be received within minutes, and if none is 
received in 5 minutes then repeat the Distress Alert or Message.  
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Sending a Distress Message 
A Distress Message should always be sent after a Distress Alert is activated in order to 
communicate details of the situation to the rescue authorities. A Distress Message does 
NOT indicate the vessel's position, and that information should be included with the text 
of the message unless it is confirmed that the position was received with a Distress Alert. 
A Distress Message can only be sent if the Galaxy is logged into the Inmarsat system.  

If a text file Distress.txt is found in the C:\Galaxy folder, then it will be pasted 
into the text of the Distress Message. It is strongly recommended that a Distress.txt 
file be created and maintained with a description of the vessel and her crew and details 
of the current voyage. (The Distress.txt file can be accessed by selecting Distress 
Text from the Window menu). 

To send a Distress Message, exit any dialog boxes that may be open (such as the address 

book), and either click the  button, select Send Distress Message from the Distress 
menu, or type Alt+D and then M. A blank Message Window will appear, and over it a 
dialog box for selecting a destination LES. The default LES will be the last one selected for 
a Distress Alert or a Distress Message, or the NCS. If the LES indicated is the nearest or 
most appropriate, select it by clicking OK or hitting the enter key; otherwise, select a 
more appropriate station with the mouse or up/down arrow keys, then click OK or hit 
the Enter key. 

If a Distress.txt file was found, that text will appear in the Message Window and can 
be edited or deleted in the same manner as editing any text. If you simply start typing, 
additional text will be entered immediately following the text from the Distress.txt file. 

When the message is complete, click the Send button or choose Send from the File menu. 
A dialog box will appear asking you to confirm that a distress message should be sent; 
select Yes if this is for real. You can also attempt to close the Message Window, and a 
dialog box will appear asking if you want to send the Distress Message; again select Yes 
if you want the message sent (otherwise it is stored in the message index without being 
sent, and can be sent later). 

Note that a Distress Message is always a Distress Message, even if it is stored in the 
Message Index and sent later (one of the funny codes at the top of the message flags it as 
a distress message). Whenever a Distress Message is sent, a dialog box will appear asking 
for confirmation. There is no way to send a stored distress message as an ordinary 
message, except by pasting its text into another message. 



Nebula 

Page 28  

Activating a Distress Alert 
A Distress Alert is a coded message that indicates the vessel's position, speed, heading, 
and an indication of the nature of the distress. A Distress Alert is activated by pressing 
and holding the two red Distress buttons on the Galaxy transceiver for 5 seconds, or by 
activating a Distress Alert from a Remote Alert Panel if so equipped. Activating an Alert 
from the PC is not permitted by Inmarsat specs, and is disabled.  

A Distress Alert signal includes provision for a code indicating the nature of the distress, 
such as "Sinking" or "Piracy/Armed Attack". A Distress Alert activated at the Galaxy 
transceiver will indicate "Unspecified Emergency" unless a distress category is previous 
selected and updated from the PC.  

To update the Distress Alert parameters, select Distress Alert from the Distress menu, or 
type Alt+D and then A. A dialog box will appear showing the distress type, LES, and vessel 
position. Select the most appropriate coded distress type by clicking with the mouse or 
using the up/down arrows. 
These codes are fixed, and if 
none are appropriate then 
leave the selection at 
"Unspecified".  

The LES indicated will be the 
one most recently used for a 
Distress Alert or a Distress 
Message, or will be the 
current NCS. If this choice is 
not appropriate, then choose 
another with the mouse or by 
typing Alt+L and then using 
the up/down arrow keys to 
select from the list.  

Verify that the position 
information is correct. If the 
Galaxy's GPS position is 
current, then the figures will appear gray instead of black and cannot be changed. If the 
Galaxy's GPS is inoperative for any reason, the position figures will be enabled and 
should be corrected as required.  

To send the updated parameters to the Galaxy, click the Update button or type Alt+U. To 
activate a Distress Alert, press and hold both red buttons on the Galaxy transceiver for 5 
seconds  
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Keyboard Shortcuts: 

From any window: 
• Alt + Home returns to the Message Index (except for the Address book, which is 

not an MDI window).  

• Esc closes any window, except for the Message Index where it restores the 
default Sort-by-Date. 

• The Alt key by itself accesses the menu bar, starting with the control menu under 
the logo icon at the upper-left corner. Use the arrow keys to move around the 
menu choices; use Esc to cancel the menu-access mode. 

• Alt with a letter key opens the corresponding menu selection. 

From the Message Index: 
• ↑↑↑↑ and ↓↓↓↓ select the next or previous message. 

• Shift + ↑↑↑↑ and Shift + ↓↓↓↓ extend a selection up or down. 

• Ctrl+Home and Ctrl+End move the message selection to the top and bottom of 
the index. 

• Any letter key selects the next message with a To or From address beginning 
with that letter. 

• F3 finds and selects the next message with the same To or From address. 

• Enter opens the selected message(s). 

From a Message Window: 
• Press Alt + PgDn or Alt + ↓↓↓↓ to view the next message (i.e. the message referenced 

by the previous line in the Message Index).  

• Press Alt + PgUp or Alt + ↑↑↑↑ to view the previous message (i.e. the message 
referenced by the previous line in the Message Index).  

• The usual windows editing keys are active, the most common are: Home and End 
position the Insertion Point at the beginning and end of the line; Ctrl + Home and 
Ctrl + End position the IP at the beginning and end of the message; Ctrl+ any 
arrow key moves the cursor by one word horizontally or one line or paragraph 
vertically; Shift + any of the insertion-point-moving keys extends a selection from 
the IP; Ctrl + C copies text to the clipboard; Ctrl + P pastes text from the 
clipboard; Ins toggles the insert/overwrite mode.  

In the Address Book: 
• Ctrl + P pastes the clipboard into the Destination number or Preamble 

• F1 calls up a Country Code reference if the insertion point is positioned in the 
Country Code box. 

Note: The Windows "Insertion Point" is the vertical bar that marks the point where text 
will be inserted. The IP is not the same as the mouse cursor, which is an I-beam when 
over a text window, but if the left mouse button is clicked while the mouse pointer is 
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over text, then the IP will jump to that point in the text. Holding the left mouse button 
down and dragging the mouse will extend a selection from the initial click point.   
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Setting Options  
Selecting Options from the Tools menu brings up the Options dialog window, which 
contains five pages for setting various options.  

Galaxy Options 
The fist page is for setting Galaxy options 
and is shown at right.  

Inmarsat Mobile #: The mobile terminal 
number assigned by Inmarsat, 9 digits 
starting with "4".  

Max Send Length: The largest message 
that will be accepted for transmission by 
the Galaxy. The upper limit of the 
Inmarsat-C system is 31,616 characters 
but setting a lower limit may be desirable 
to prevent the costly error of sending a 
long file by mistake. 

Status Update: Time interval between 
updates of the Galaxy status and position 
displays, in seconds (default is 2 seconds).  
Galaxy Serial port: The communications 
port used for the Galaxy serial connection. 
The default is COM1, and use of this port 
rather than an add-on port is suggested 
for reliability. 

Galaxy Password: A cryptic Password 
supplied with the Nebula program that identifies the particular Galaxy transceiver that it 
is connected to.  

Diagnostic Events: Checking this box enables Diagnostic Event Messages in addition to 
the regular Event Messages. Open the Event Window (Events under the Window menu) to 
view all event messages. Note: This appears to conflict with Nebula's poll of the Galaxy 
clock and causes the DCE to hang under DCE version 4.20. It is therefore recommended 
that Diagnostic Events NOT be enabled for normal use. 

Auto NCS Scan: Checking this box enables the Galaxy DCE box to periodically scan the 
NCS for the strongest channel.  

Auto Alarm Silence: Checking this box allows the Nebula program to automatically 
silence the Galaxy alarm after 3 to 5 seconds when an "Urgent" or "Distress" EGC 
message is received. Note that the alarm will only be silenced if the program is running 
(the alarm cannot be permanently silenced on a Galaxy Marine unit), and silencing the 
alarm automatically is not permitted for vessels obliged to participate in the GMDSS.  

Write Debug File: Checking this box causes Nebula to maintain a chronological log of 
debug information in the file \Galaxy\Debug.txt. This is only useful if  software or 
hardware difficulties are encountered. 

Log Galaxy I/O: For diagnostic use only.  
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Show Header Info: Checking this box causes a header line to be added to each incoming 
message, showing the originating LES, and for EGC messages, the Service Code. This is 
cute but generally useless.   

Note that the Inmarsat Mobile#, Max Send Length, Diagnostic Events and Auto NCS Scan 
are stored in the Galaxy DCE box and will not be available if there is no Galaxy connected.  

Sound Options 
The second option page controls the 
sound alerts for new mail and EGC 
messages, and can be selected by typing 
Ctrl/Tab or by clicking on the Sound page 
tab.  

Systems without a sound card are limited 
to the default Windows "beep", but with a 
sound card any .WAV file can be used for 
audio alerts. Three files are included with 
Nebula. EGCclick.wav produces a 
distinctive "thunk" for new EGC messages,  

NewMail1.wav produces a particularly 
obnoxious warble for new mail messages, 
and NewMail2.wav produces a slightly 
less obnoxious warble for repeated alerts. 
Any other .wav can be used, or you may 
wish to demonstrate good taste be 
selecting Quiet.  

 

 



Nebula 

Page 33  

Message Routing Options 
Routing of incoming and outgoing mail messages and incoming EGC messages is 
controlled by the options on the Routing page of the Options Window. To view the 
Routing options, open the Options window as above and either press Ctrl/Tab twice or 
click the Routing page tab.  

Note that the Root Folder is shown at the top. This is set during installation and cannot 
be changed here, and all other folders must be under the designated root folder.  

Although any folder scheme can be used, two are recommended. If Nebula is to be used 
interchangeably with Trimble's Galaxy DOS program, then it may be desirable to stick 
with the DOS program's file folder (directory) layout. For general use with Nebula, 
however, the fact that the DOS program used the same folder for multiple message types 
limits the usefulness of Nebula's Folder Tree and makes message management more 
difficult. For that reason the folder arrangement shown at right is the recommended one.  

Note that if the folders are not set appropriately then messages can be lost. 

Incoming Messages: The first selection  
defines the "Inbox" folder where incoming 
mail messages are stored when received 
from the Galaxy, normally \Inbox. To use 
the folder arrangement defined by the 
Galaxy DOS program, this would be set to 
\NewMail. The second selection is the 
folder that messages are moved to when 
"Filed", normally \Inbox\Saved as 
shown, or \Messages to match the DOS 
program usage. .  

EGC Messages: The first selection defines  
the folder where incoming EGC messages 
are stored when received from the Galaxy, 
normally \EGC. (or \NewMail to match the 
DOS program usage). The second selection 
is the folder that EGC mesages are moved 
to when "Filed", normally \EGC\Saved, or 
\Messages to match the DOS program 
usage. 

Outgoing Messages: This selection defines 
the folder that newly created outgoing 
message are stored into, normally 
\Outbox, or \Messages to match the DOS 
program usage.  
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Folder Options 
The next page of the Options window 
shows Folder options. A view of the Folder 
Tree is displayed, showing all folders 
including folders that are normally hidden 
from the Folder Tree.  

Hidden folders are indicated by a draped 
folder icon, , and include any that are 
not normally used for messages. In the 
example at right, hidden folders include 
those for log files as well as folders used 
by the DOS program but not by Nebula as 
configured on the Routing page, namely 
the Newmail and Messages folders. The 
Recvfrm, Xmitfrm, and Xmitfdo folders 
would also normally be hidden if retained.  

To hide a folder, select it with the mouse 
or arrow keys and then click the Hide 
button or type Alt/H. Similarly, to show a 
hidden folder, select it in the same way 
and click Unhide or type Alt/U.  

To create a new folder, first select the 
existing folder that the new folder will be 
under by using the mouse or arrow keys, 
and then click the New button or type Alt/N. A new folder will be created with the name 
"NewFolder" selected and open for editing to a new name.  

To rename a folder, select it as above and either click on the name again to open it for 
editing (in the same fashion as Explorer), or click the Rename button or type Alt/R. Hit 
the Enter key or select another folder to finish editing and save the changes, or press the 
Esc key to abandon any changes.  

To delete an existing folder, first be sure that it does not contain any files that you want 
to save, and then select the folder as above and click the Delete button (or hit Tab 
repeatedly until Delete is outlined and then hit Enter).  
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NMEA Output Options 
The last page of the Options Window is used to set up an optional NMEA output, so that 
the Galaxy can be used as a source of GPS information to a plotter or instrument system. 
The Galaxy box provides an NMEA output on a rear-panel connector, but the GGA 
sentence used for GPS position is not recognized by many plotters and no provision is 
made for waypoints. The Nebula interface extracts the GPS information from the Galaxy 
status messages and formats a series of NMEA sentences on a separate RS-232 port. 
There are limitations to the use of the Galaxy as a GPS source which are outlined below 
and must be understood.  

NMEA COM Port: This selects the output 
port for NMEA sentences, or blank to 
disable NMEA output. This must not be 
the same port as is used for Galaxy 
communications, and cannot be a port 
used by any other device. It is possible to 
connect this port to another on the same 
computer, for example to supply GPS 
information to a plotting program.  

COG/SOG Average: This defines the 
averaging period for the COG/SOG NMEA 
output. If set to zero, SOG is output as 
received by the Galaxy which is only to the 
nearest knot. The averaging used in a 
least-squares fit on Lat/Lon to 
thousandths of a minute, but due to the 
realities of measurement and timing 
uncertainties (to say nothing of SA) an 
averaging period of at least 60 seconds 
should be used.  

Waypoint: This defines the Lat/Lon 
position that is used as the destination for 
waypoint calculations (BWC, BWR, WCV 
and ZTG sentences).  

Magnetic Variation: The current variation should be entered in order that magnetic 
bearings be reported correctly. 

The NMEA sentences that are output are GLL, BWC, BWR, VTG, WCV , ZTG, ZTA, and ZLZ, 
all with a $GP prefix.  

Note: Trimble does not support the use of the Galaxy GPS for routine position-fixing, 
because the Galaxy's GPS receiver can be interrupted for arbitrarily long periods by the 
requirements of the Standard-C transceiver, particularly when transmitting or 
automatically responding to incoming messages.  
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Passwords 
The Nebula program uses a password that is keyed to the Inmarsat Serial Number of a 
particular Galaxy unit (identified by the label on the top of the box). The normal 
password is 10 digits prefixed by "IPW-" (Inmarsat Password) and normally never needs 
to be dealt with. The password is stored in the Nebula.ini file or in the system 
registry, and will be automatically accessed when the program is started, even when 
software updates occur. The password is keyed to the Inmarsat Serial number, not the 
Trimble Harware serial number, and this number remains the same for a particular unit 
(even if the box electronics are swapped by Trimble Service).  

An alternate date-coded password can be supplied to allow demo use or temporary use 
of a program on another box. A dated or "Use-by" password is prefixed by "UB-", followed 
by six digits for the expiration date (YYMMDD), followed an eight-digit code. Use-by 
passwords are valid until 23:59UTC on the expiration date. 
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OLE Position Interface 
An OLE Automation Server interface provides access to the Galaxy's GPS position if 
desired. One ClassID is provided, Nebula.Position, and one function in that class, 
GPSposition, which returns a comma-delimited string variant with Fix Time, Latitude, 
Longitude, Course-Over-Ground (COG), Speed-Over-Ground (SOG), and fix status.  

Data is presented as received from the Galaxy, Lat/Lon to thousands of a minute, COG to 
the nearest degree, SOG to the nearest knot, and with no averaging. Latitude and 
longitude are presented as DDD.MMmmm, where DDD=degrees, MM=minutes, and 
mmm=thousanths of minutes, and south latitudes and East longitudes are negative. COG 
is degrees true, SOG is in knots, and fix status is "0" for a good fix, "1" for more than one 
minute old, "2" for more than 4 hours old, and "3" for more than 24 hours old. 

Before Nebula can be called as an OLE Automation Server, it must be registered as such 
with Windows. This is done by executing the command line 
C:\Galaxy\Nebula.exe /Regserver using the Run command from the Windows 
Start Menu. To remove the registration, execute the command 
C:\Galaxy\Nebula.exe /Unregserver. When called to register or unregister, 
Nebula returns without starting the program proper. Registration need only be done once 
(unless classes or functions are added in a future release). 

An EXCEL macro follows that demonstrates Nebula's OLE Server function by storing data 
in successive rows at 10 second intervals. The basic method is to establish an OLE link to 
Nebula by creating a "Nebula.Position" object, then make calls to the GPSposition 
function at intervals to get the position string. Here, this string is first stored  in a single 
cell and then Excel's TextToColumns function is called to parse the comma-delimited 
string. The critical steps are shown in bold type.  

 

Option Explicit
Public Galaxy As Object
Public MaxCols, CurrentRow
Public DataPeriod
'
'Anything named Auto_Open gets called automatically
'when the form is loaded...
'Create link to Nebula and initialize header line.
'then get first line of data (which will start timer)
'
Sub Auto_Open()

DataPeriod = TimeValue("00:00:10")
Set Galaxy = CreateObject("Nebula.Position")
Sheets("Data").Cells.ClearContents
'Make header by storing string and then parsing in the same fashion as data
Sheets("Data").Cells(1, 1).Formula = "Fix Time,Latitude,Logitude,COG,SOG,

status"
Sheets("Data").Cells(1, 1).TextToColumns comma:=True, DataType:=xlDelimited
CurrentRow = 2
GetData

End Sub
'
'Spreadsheet closing, chop link to Nebula
'
Sub Auto_Close()

Set Galaxy = Nothing
End Sub
'
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'Get a tab-delimited line of data, convert to cells, set timer to call again
'
Sub GetData()

Dim icol
Static runtime
If CurrentRow = 0 Then CurrentRow = 2
Sheets("Data").Cells(CurrentRow, 1).Formula = Galaxy.GPSposition
Sheets("Data").Cells(CurrentRow, 1).TextToColumns comma:=True, DataType:=

xlDelimited
CurrentRow = CurrentRow + 1
runtime = DataPeriod + Int((Now + DataPeriod / 2) / DataPeriod) * DataPeriod
Application.OnTime runtime, "GetData"

End Sub
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Technical Matters 

Windows Performance Issues:  
Nebula is written for Windows-95, and will not run under Windows 3.1 or 3.11. It has not 
yet been tested under Windows NT but there are no known limitations. The minimum 
practical configuration to run Windows-95 is 8 megabytes of memory, and Nebula has 
been extensively tested in that configuration and runs without any performance 
degradation as the sole real-time application. Note that Nebula sets its priority two steps 
above normal, and the priority of its Galaxy communications thread one step above 
normal in order to minimize communication time-outs that otherwise occur on small 
configurations running multiple large applications. The effect is that if resources are 
constrained, Nebula will get what it needs but other non- real time applications may 
suffer.  

To run Nebula concurrently with a weather fax program or data logging, it is 
recommended that at least 12 megabytes of memory be provided. Providing additional 
RAM memory, up to 16 or 20 megabytes, will provide a much greater performance boost 
for Windows than a faster processor. It is also important that at least 5 megabytes of 
disc space, and preferably two to three times that, be free for Windows to use as a swap 
file.   

Debug File: 
A debug file, C:\Galaxy\Debug.txt, is optionally written with status information for 
significant events detected by the program. Writing the debug file is controlled by the 
Options window under the Tools menu. If the debug file is enabled, then it can be 
examined by selecting Debug File under the Tools menu. If the debug file is left enabled, 
it will grow without bounds and must be trimmed from time to time.  

Galaxy Event Messages: 
The most recent 100 Galaxy event messages are stored in C:\Galaxy\Events.txt, 
and can be examined by selecting the Events under the Window menu. The events are 
listed in chronological order as received from the Galaxy, with a date and time stamp 
appended to the beginning (taken from the computer clock). If Diagnostic Messages are 
selected from the Options window, then Diagnostic Event Messages are stored in the 
event list also. Note that there is a bug in the Galaxy DCE firmware that generates D0000 
diagnostic events, and these appear to interfere with message transfers. It is therefore 
strongly recommended that Diagnostic Events NOT be enabled for normal use.  

Galaxy Communications: 
Serial communications with the Trimble Galaxy DCE unit are handled via a dedicated 
execution thread to avoid conflicts with the user interface. The standard Windows serial 
device drivers are used, with 32K buffers in each direction to accommodate the largest 
possible message.  

A 10-second time-out is provided on Galaxy messages in response to queries, and a 30-
second time-out is provided on loss of status information. If a status time-out occurs, 
the Galaxy will be disconnected and a reconnect attempt made at 10-second intervals. 
Nebula and its communication thread run with slightly higher-than-normal priority so 
timeouts are not expected, even on a heavily-utilized computer. Problems can occur if 
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Nebula is minimized (which reduces priority) and a compute-intensive program is run in 
the foreground.  

The most common problem with Galaxy communications is selecting the wrong serial 
port. It is recommended that COM1 be used if there are any difficulties. If difficulties 
continue, check the Settings and Drivers under the Windows-95 Device Manager (right-
click "My Computer" and select "Properties"); the drivers should be Serialui.dll and 
Serial.vdx.  

Computer Clock: 
If the computer's clock is set to UTC and off by a small amount, it will reset by Nebula 
from the Galaxy's satellite-based real-time clock. The clock is checked at one-hour 
intervals, and errors of less than 10 seconds or more than 10 minutes are not corrected. 
Note that the system time zone must be set so that the Windows API call GetSystemTime 
reports the correct UTC time. One way to do this is to set the local computer time to UTC 
and the Time Zone to GMT/Monrovia (The GMT/Dublin…London setting gets messed up 
with Daylight Saving Time even when you tell it not to). The other option is to set the 
system clock to local time and set the Time Zone appropriately. Refer to the Windows 
Control Panel Date/Time settings.   
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Telex Country Codes 
Note: While this list was compiled from sources believed to be correct, mistakes get 
made and things change. Some errors and omissions are certain and codes should be 
verified wherever possible. Updates are most welcome.  

Inmarsat  Regions: 
Inmarsat AOR/E...... 581 
Inmarsat POR......... 582 
Inmarsat IOR .......... 583 
Inmarsat AOR/W .... 584 
 
Country: 
Afghanistan............... 79 
Alaska, USA (RCA). 200 
Albania.................... 604 
Algeria .................... 408 
Andorra................... 590 
Angola .................... 991 
Anguilla................... 391 
Antigua ................... 393 
Argentina .................. 33 
Ascension Is. .......... 939 
Australia.................... 71 
Austria ...................... 47 
Azores (Portugal) .... 404 
Bahamas................. 297 
Bahrain ................... 490 
Bangladesh............. 780 
Barbados ................ 392 
Belgium..................... 46 
Belize...................... 371 
Benin ...................... 972 
Bermuda ................. 290 
Bolivia ..................... 309 
Botswana................ 962 
Burkina Faso........... 978 
Brazil......................... 38 
Brunei ..................... 809 
Bulgaria .................... 67 
Burundi ................... 903 
Cameroon............... 970 
Canada ..................... 21 
Canary Is. ................. 52 
Cape Verde Is......... 993 
Cayman Is............... 293 
Central African Rep.......  
............................... 971 
Chad ....................... 976 
Chile ......................... 34 
China ........................ 85 
Christmas Is............ 766 
Cocos Keeling Is..... 766 
Columbia (Republic of) .  
................................. 35 
Congo PR ............... 981 
Cook Is. .................. 772 
Costa Rica .............. 376 
Cuba ......................... 28 
Cyprus .................... 605 
Czechoslovakia......... 66 
Denmark ................... 55 
Djibouti.................... 979 

Dominica ................ 394 
Dominican Rep ....... 202 
Ecuador .................. 308 
Egypt AR .................. 91 
El Salvador ............. 373 
Equatorial Guinea... 999 
Ethiopia .................. 980 
Falkland Is. ............. 306 
Faeroe Is. ............... 502 
Fiji........................... 701 
Finland...................... 57 
France ...................... 42 
French Guiana........ 300 
French Polynesia 
(Tahiti) ..........................  
............................... 702 
Gabon (Gabonese Rep) 
............................... 973 
Gambia................... 996 
Germany (ex- DDR).. 69 
Germany (ex- FDR) .. 41 
Ghana....................... 94 
Gibraltar.................. 405 
Greece.................... 601 
Greenland............... 503 
Grenada ................. 395 
Guam...................... 700 
Guatemala.............. 372 
Guinea.................... 995 
Guinea Bissau ........ 969 
Guyana................... 295 
Haiti ........................ 203 
Hawaii (RCA).......... 704 
Hawaii (AACR) ....... 705 
Hawaii (Data Tel).... 773 
Hawaii (WUH)......... 709 
Honduras................ 374 
Hong Kong.............. 802 
Hungary.................... 61 
Iceland.................... 501 
India.......................... 81 
Indonesia.................. 73 
Iran ........................... 88 
Iraq ......................... 491 
Ireland .................... 500 
Israel ...................... 606 
Italy........................... 43 
Ivory Coast ............. 983 
Jamaica .................. 291 
Japan........................ 72 
Jordan .................... 493 
Kampuchea ............ 807 
Kenya ..................... 987 
Kiribati .................... 761 
Korea PDR ............. 899 
Korea Rep .............. 801 
Kuwait..................... 496 

Laos ........................804 
Lebanon ..................494 
Lesotho ...................963 
Liberia .....................997 
Libya........................901 
Liechtenstein .............45 
Luxembourg ............402 
Macao .....................808 
Madagascar ............986 
Malawi .....................904 
Malaysia ....................84 
Maldive Is. ...............896 
Mali .........................985 
Malta .......................406 
Mariana Is. And Saipah . 
................................760 
Marshal Is................765 
Martinique ...............298 
Mauritania ...............974 
Mauritius..................966 
Mexico.......................22 
Micronesia...............764 
Monaco .....................42 
Montserrat ...............396 
Morocco ..................407 
Mozambique............992 
Myanmar ...................83 
Namibia ...................908 
Nauru Is...................775 
Nepal.......................891 
Netherlands...............44 
Netherlands Antilles 390 
New Caledonia ........706 
New Zealand .............74 
Nicaragua................375 
Niger .......................975 
Nigeria.....................905 
Niue Is. ....................776 
Norfolk Is. ................766 
Norway......................56 
Oman ......................498 
Pakistan ....................82 
Panama...................379 
Papua New Guinea .703 
Paraguay.................305 
Peru ..........................36 
Philippines.................75 
Poland.......................63 
Portugal...................404 
Puerto Rico .............206 
Qatar .......................497 
Reunion...................961 
Romania....................65 
Rwanda ...................909 
St. Helena ...............960 
St. Kitts-Nevis..........397 
St. Lucia ..................398 

St. Pierre/Miquelon..204 
St. Vincent/Grenadines . 
................................399 
Samoa (US) ............770 
Samoa (Western)....779 
San Marino..............505 
Sao Tome/Principe..967 
Saudi Arabia ...........495 
Senegal...................906 
Seychelles...............965 
Sierra Leone ...........998 
Singapore..................87 
Solomon Is. .............778 
Somalia DR.............900 
South Africa ..............95 
Spain.........................52 
Sri Lanka.................803 
Surinam...................304 
Swaziland................964 
Sweden.....................54 
Switzerland ...............45 
Syria........................492 
Taiwan ....................785 
Tanzania .................989 
Thailand ....................86 
Togo........................977 
Tonga......................777 
Trinidad & Tobago...294 
Tunisia ....................409 
Turkey.....................607 
Turks & Caicos Is....296 
Uganda ...................988 
UAE ........................893 
UK.............................51 
Uruguay ....................32 
USA ..........................23 
USSR........................64 
Vanuatu...................771 
Vatican City.............504 
Venezuela .................31 
Vietnam...................805 
Virgin Is. (British).....292 
Virgin Is. (US)..........208 
Yemen AR...............895 
Yemen PDR ............806 
Yugoslavia ................62 
Zaire........................982 
Zambia....................902 
Zimbabwe ...............907 
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 Telephone/Fax Country Codes 
Note: While this list was compiled from sources believed to be correct, mistakes get 
made and things change. Errors and omissions are certain and updates are most 
welcome.  

 

Afghanistan............... 93 
Albania.................... 355 
Algeria .................... 213 
Andorra..................... 33 
Angola .................... 244 
Anguilla............. 1+809? 
Antigua ............... 1+268 
Argentina .................. 54 
Aruba ...................... 297 
Ascension Is. .......... 247 
Australia.................... 61 
Azores ................... 351 
Bahamas............. 1+242 
Bahrain ................... 973 
Bangladesh............. 880 
Barbados ............ 1+246 
Belgium..................... 32 
Belize...................... 501 
Benin ...................... 229 
Bermuda ............. 1+441 
Bolivia ..................... 591 
Botswana................ 267 
Burkina Faso........... 226 
Brazil......................... 55 
Brunei ..................... 673 
Bulgaria .................. 359 
Burma ....................... 95 
Burundi ................... 257 
Cameroon............... 237 
Canada ....................... 1 
Canary Is. ................. 34 
Cape Verde Is......... 238 
Cayman Is........... 1+345 
Central African Rep. 236 
Chad ....................... 235 
Chile ......................... 56 
China ........................ 86 
Christmas Is............ 682 
Cocos Keeling Is..... 682 
Colombia................... 57 
Congo PR ............... 242 
Cook Is. .................. 682 
Costa Rica .............. 506 
Cuba ......................... 53 
Cyprus .................... 357 
Czechoslovakia......... 42 
Denmark ................... 45 
Djibouti.................... 253 
Dominican Rep. 1+809?  
Ecuador .................. 593 
Egypt AR................... 20 
El Salvador ............. 503 
Equatorial Guinea ... 240 
Ethiopia................... 251 
Falkland Is. ............. 500 
Faeroe Is. ............... 298 
Fiji ........................... 679 
Finland.................... 358 

France ...................... 33 
French Guiana........ 594 
French Polynesia.... 689 
Gabon..................... 241 
Gambia................... 220 
Germany (ex-DDR)... 37 
Germany (ex-FDR) ... 49 
Ghana..................... 233 
Gibraltar.................. 350 
Greece...................... 30 
Greenland............... 299 
Grenada ........... 1+784? 
Guam...................... 671 
Guatemala.............. 502 
Guinea.................... 224 
Guinea Bissau ........ 245 
Guyana................... 592 
Haiti ........................ 509 
Honduras................ 405 
Hong Kong.............. 852 
Hungary.................... 36 
Iceland.................... 354 
India.......................... 91 
Indonesia.................. 62 
Iran ........................... 98 
Iraq ......................... 964 
Ireland .................... 353 
Israel ...................... 972 
Italy........................... 39 
Ivory Coast ............. 225 
Jamaica .............. 1+876 
Japan........................ 81 
Jordan .................... 962 
Kenya ..................... 254 
Kiribati .................... 686 
Korea PDR ............. 850 
Korea Rep ................ 82 
Kuwait..................... 965 
Lebanon.................. 961 
Lesotho................... 266 
Liberia..................... 231 
Liechtenstein ............ 41 
Luxembourg............ 352 
Macao..................... 853 
Madagascar............ 261 
Madeira .................. 351 
Malawi .................... 265 
Malaysia ................... 60 
Maldive Is. .............. 960 
Mali......................... 223 
Malta....................... 356 
Marshall Is. ............. 692 
Martinique............... 596 
Mauritania............... 222 
Mauritius................. 230 
Mexico ...................... 52 
Micronesia .............. 691 
Monaco..................... 33 

Montserrat ...........1+664 
Morocco ..................212 
Mozambique............258 
Myanmar ...................95 
Namibia ...................264 
Naulu Is. ..................674 
Nepal.......................977 
Netherlands...............31 
Netherlands Antilles 599 
New Caledonia ........687 
New Zealand .............64 
Nicaragua................505 
Niger .......................227 
Nigeria.....................234 
Niue Is. ....................683 
Norfolk Is. ................672 
Norway......................47 
Oman ......................968 
Pakistan ....................92 
Panama...................507 
Papua New Guinea .675 
Rwanda ...................250 
St. Helena ...............290 
St. Kitts-Nevis......1+869 
St. Lucia ..............1+758 
St. Pierre/Miquelon..508 
St. Vincent/Grenadines.. 
............................1+784 
Samoa (US) ............684 
Samoa (Western) ....685 
San Marino...... 39 (295) 
Sao Tome/Principe..239 
Saudi Arabia............966 
Senegal ...................221 
Seychelles...............248 
Sierra Leone............232 
Singapore..................65 
Solomon Is. .............677 
Somalia DR .............252 
South Africa...............27 
Spain.........................34 
Sri Lanka...................94 
Surinam...................597 
Swaziland................268 
Sweden .....................46 
Switzerland................41 
Syria........................693 
Taiwan.....................886 
Tanzania .................255 
Thailand ....................66 
Togo........................228 
Tonga......................676 
Trinidad & Tobago......... 
............................1+868 
Tunisia.....................216 
Turkey .......................90 
Turks & Caicos Is. ......... 
............................1+649 

Uganda ...................256 
UAE ........................971 
UK.............................44 
Uruguay ..................598 
USA ............................1 
USSR..........................7 
Vanuatu...................678 
Vatican City...............39 
Venezuela .................58 
Vietnam.....................84 
Virgin Islands (British) ... 
............................1+284 
Virgin Islands (US) ........ 
............................1+340 
Yemen AR...............967 
Yemen PDR ............969 
Yugoslavia ................38 
Zaire........................243 
Zambia....................260 
Zimbabwe ...............263 
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Abbreviations and Service Codes 
ABS Absent subscriber 
ACB Access barred 
ADR Addressee refuses 
ANUL Delete 
ATD Attempting to deliver the message 
BK Message aborted 
BMC No end of message or end of transmission 

received 
BUS Busy 
CCD Call cut or disconnected 
CFM Please confirm, I confirm 
CIE The CES ran out of 

processing/communications capacity 
CNS Call not started 
COL Collation please/I collate 
CRV Do you receive well?/I receive well 
DER Out of order 
DF You are in communication with the called 

subscriber 
DTE Remote DTE clearing 
EOS Element of service not described (X.400) 
FAU Faulty 
FMT Format error 
FSA Fast select acceptance not subscribed 
GA You may transmit/May I transmit? 
IAB Invalid answerback 
IAM Unable to process the address information 
IDS Invalid data from ship 
IDT Input data timeout 
IFR Invalid facility request 
IMS Message size is invalid, 7932 characters 

max 
INC Inconsistent request (X.400) 
IND Incompatible destination 
INF Call the network information center 
INH Was unable to establish the type of 

message from the following header: 
INV Invalid call 
ISR Invalid ship request 
ITD Awaiting delivery 
ITL I transmit later 
JFE Office closed because of holiday 
LDE Maximum message length exceeded 
LEF Local equipment failure 
LPE Local procedure error 
MBB Message broken by higher priority 
MCC Message channel congestion 
MCF Message channel failure 
MKO Message killed by operator 
MNS Minutes 
MOM Wait/waiting 
NA Access barred 
NAL No address line is present 
NDA There was no delivery attempted 
NC Network congestion 
NCH Subscriber’s number changed 
NFA No final answerback 
NI No line identification available 
NIA No initial answerback 
NOB Not obtainable 
NOC No connection 
NP No party/not obtainable 

NR Indicate your call number/my call number 
is… 

NRC Reverse charging acceptance not 
subscribed 

NTC Network congestion 
OAB Operator aborted 
OCC Telex occupied/number busy 
OK Agreed/do you agree? 
OOO Out of order 
P Stop your transmission 
PPR Paper 
PRC Premature clearing 
PRF Protocol failure 
R Received 
RAP In shall call you back 
RCA Reverse charging acceptance not 

subscribed 
RDI Redirected call 
REF There was a failure in the remote 

equipment 
RIS Recipient improperly specified (X.400) 
RLE Resource limit exceeded 
RPE Remote procedure error 
RPO RPOA out of order 
RPT Repeat/I repeat 
RSB (RSBA) Retransmission still being 

attempted 
SCC Call completed successfully 
SHE SES hardware error 
SNF The satellite network has failed 
SPE SES protocol error 
SSSS Change of alphabet 
SUC Test results being delivered 
SVP Please 
TAX What is the charge/the charge is… 
TBY Trunks busy 
TEST MSG Please send a test message 
TGR TDM group reset 
THRU You are in communication with a telex 

position 
TIM Timeout 
TMD Maximum number of addresses exceeded 
TPR Teleprinter 
UNK Unknown status (when logical channel 

number is zero) 
W Words 
WFA Wrong final answerback 
WIA Wrong initial answerback 
WRU Who is there? 
XXXXX Error 



Nebula 

Page 44 

Inmarsat-C 2-digit Service Codes 
The following service codes are used in the Inmarsat-C system. Not all LES's have 
implemented 2-digit codes, and not all codes are supported by those LES's that have 
implemented them. When used, the 2-digit service codes appear in the Prefix portion of 
an address as a special access code. Consult the LES for details.  
 
00 Automatic telex calls using international telex country codes 
31 Maritime enquiries 
32 Request for medical advice 
33 Request for technical assistance 
37 Time and charges requested 
38 Request for medical assistance 
39 Request for maritime assistance 
41 Sending weather reports to meteorological centers 
42 Sending navigational and weather dangers to shore authorities 
43 Ship position reports (e.g. AMVER) 
6(x) Administration specialized use (e.g. leased lines) 
68 Information service 
91  Automatic line test 
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Glossary 
AOR/E Atlantic Ocean Region East, roughly 60°E to 90°W at the equator 

AOR/W Atlantic Ocean Region West, roughly 20°E to 130°W at the equator 

CES: Coast Earth Station, same as LES. These are the stations with the big dishes that 
provide the link to the terrestrial communications systems.  

Comsat The US provider of Inmarsat satellite communication services. Provides telex, 
outgoing fax and email service, as well as transcription service for incoming fax and 
telephone messages. Service to three Ocean Regions.  

Email Electronic Mail. The term "email" usually refers to messages sent via the internet, 
although other systems (such as X.400) are also used.   

EGC Enhanced Group Call, the signaling method used to transmit weather messages and 
notices on a selective basis to all Inmarsat-C terminals.  

Inmarsat INternational MARitime SATellite Organization, the organization that oversees 
international maritime satellite services.  

Inmarsat-C The least expensive of the various Inmarsat satellite communications units. A small 
antenna, reasonable power consumption and a modest price (compared to the larger 
Inmarsat systems) make this a practical choice for smaller vessels. Data only (telex 
or email).   

IOR Indian Ocean Region, roughly 140°E to 10°W at the equator 

LES: Land Earth Station, same as CES 

MES: Mobile Earth Station, i.e. the Trimble Galaxy Inmarsat-C/GPS Marine Transceiver 

O.R. Ocean Region, the geographic areas served by the four Inmarsat satellites, POR, 
AOR/W, AOR/E, IOR.  

POR Pacific Ocean Region, roughly 100°W to 100°E at the equator 

Practice The opposite of "Theory". 

Satcom-C Same as Inmarsat-C, used by folks that can't spell "Imnarsat".  

Station-12 The group of LES's operated by PTT Telecom Netherlands. Besides Comsat, the 
only other known email service provider. Also provides telex and outgoing fax service 
to all four Ocean Regions.  

Theory A small town in Indiana where every printer works with every computer, and email 
always gets through. See "Practice".  

TLA Three Letter Acronym 
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